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Traveling on Your Desktop
by Sue Beal

MU

Our August meet-
ing was a delightful 
trip around the globe 
with Kathy Miller, as 
we learned how to 
use Google Earth to 
travel from our desk-
tops. Google Earth 
is called a “geo-spa-
tial database,” which 
means it pulls infor-
mation from a variety 
of sources to build 
images anywhere 
on Earth. It uses 
satellite imagery, 
maps, borders and 
terrain information, 
and even street-level 
photographs.

What Google Earth ISN’T, is a real time 
satellite view of the globe. “You can’t use 
it to spy on your hubby,” says Kathy!

To the right you see a Google Earth 
screen. It’s too small here to see, but the 
writing at the bottom tells the source of 
the image you are seeing, and the date on 
which it was taken. You might see images 
long out of date (for example, try to look 
at the new Jewfish Creek Bridge).

You will find lots of information in 
populated and popular places, like our 
Statue of Liberty on this screen. When 
you get  into remote areas, there is not as 
much information. As you zoom into an 
area without much information, you find 
the picture gets a fuzzy, and the  details 
are sketchy. In other words, it’s not there 
unless someone put it there!

Come at
6:30 for the

Beginners Circle:
New! Bring your laptop 

and your questions Sept. 10 
at 6:30, and for a half-hour
prior to the main meeting 

we'll have experienced 
folks available to help, 

one on one, or in 
small groups.

continued on page two

September 10th at 7pm,                      
  KL Library Community Room:

A screening of the 
movie “Welcome 
to Macintosh”

For our September 10th UKMUG 
meeting topic, we will have a screen-
ing of this new film:

WELCOME TO MACINTOSH is 
the first documentary of its kind 
to mix history, criticism and an 
unapologetic revelry of all things 
Apple into a movie experience. The 
film explores the early years of Ap-
ple, the many challenges Apple has 
faced, and what the future may hold 
for the company and its products. 
Ex-Apple employees, engineers and 
community members offer insight on 
the company’s innovations, failures, 
cultural impact and what the future 
may be like beyond the reign of its 
co-founder Steve Jobs. Interviews 
include notable Apple personali-
ties Andy Hertzfeld, co-creator of the 
original Macintosh, Guy Kawasaki, 
long time Mac evangelist, Leander 
Kahney, author of the book `Cult 
of Mac`, Jim Reekes, creator of the 
Macintosh start-up sound and Ron 
Wayne, original co-founder of the 
Apple Computer Company.

The film is 83 minutes long, so we 
will start on time at 7, run for 50 min-
utes, take a  break andthen  finish it... 
so you won't get home too late!

Snow Leopard is here!
by Sue Beal

The new operating system has finally 
arrived, and the word on the street is 
that is isn't a huge change from Leop-
ard. The really important information 
I got was that there are some internet 
sites that say you can download it for 
free. Don't do it! They are malware/virus 
scams! It only costs $30, so buy from a 
reputable site or dealer... and backup/
follow Tom's patented upgrade proce-
dure when installing! Let us know how 
you like it!  (More inside)

But what is there is magnificent! That 
said, let’s concentrate on how to access 
it and fine tune your Google Earth ex-
perience.

The Window
When you start it up, the Earth appears 

in the main window, called the 3D Viewer. 
You’ll see a sidebar down the left hand 
side, some controls in the upper right, 
source information at the bottom middle, 
GPS coordinates on the left bottom and 
altitude on the right bottom.

The side bar is divided into 3 parts:
  - Search: area at the top
  -  Places: your favorites/bookmarks
  - Layers: a variety of options for types 

of content you want to see.

TIP: To run faster, turn off unneeded 
Layers by unchecking the box next to 
them. This saves Google Earth extra 

processing. They are easy to turn 
back on when you want to see that 

information.

Navigating
Mouse over the globe and the cursor 

turns into a hand. Click and drag the 
hand to “pull” the globe around. Double 
click to zoom in on an area. (You can also 
zoom with the controls in the upper right, 
or by using the plus and minus keys on 
the keyboard.)
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Google Earth
continued from page one
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New York Times weighs 
in on Snow Leopard

Submitted by Graham Thomas

This is an interesting first look at the 
new OS with the NYT’s characteristic 
“big picture” view... which is a dose 
of reality for those of us who only 
read what Apple puts out! Thanks, 
Graham!

http://www.nytimes.com/2009/08/
27/technology/personaltech/27pogu
e.html?emc=tnt&tntemail1=y

Bonus Tip from Kathy:

One thing I didn’t get time to mention 
was that you should turn on “ Startup 
Tips” to learn a little something each 
time you start the program. This can 
be done by pulling down the tools 
menu, clicking options, and selecting 
the general tab. Check the radio box 
to show the startup tips.

Thanks to Denise for this one!

New Mac Software Not 
A Dramatic Change

by Peter Svensson
Associated Press Technology Writer

Thanks to Video Day Kay

The most important changes in the 
Apple operating system are under the 
hood, allowing software developers to 
rewrite their programs to run much 
faster.

Snow Leopard is a relatively cheap 
upgrade, costing $29 for an individual 
user who has Leopard, the previous 
operating system. A “family pack” for 
five users costs $49.

For Mac owners using the older 
Tiger operating system, switching to 
Snow Leopard costs $169, or $229 for 
a family pack. That “box set” includes 
the latest iLife and iWork software for 
such tasks as movie editing, photo or-
ganizing and word processing. Buying 
the DVD is the only upgrade option 
for consumers — you can’t download 
the software.

Lots more detail on this at: http:
//license.icopyright.net/user/viewFre
eUse.act?fuid=NDY2MDc0OQ== 

Working the Controls
At the left you see the controls from 

the top right of the window. The top one 
is called a Look joystick.

Grab the “N” and pull it to 
the top, or just click once on 
it and it will go there itself. 
This re-orients you on the 
compass, North up.

Inside the circle with the 
N button is a disc that has 
four directional arrows, click 
and hold on these to move in 
those directions, or in between 
to move diagonally.

The little eyeball in the cen-
ter of the disc is for tilt. This 
changes your viewing angle, 
a little strange when looking 

at the whole globe but very useful when 
you’re zoomed into a location. Make sure 
Terrain is turned on in the Layers for this. 
Google Earth uses the photos from above 
and the terrain information to generate a 
3D view from a more Earthbound angle.

The disc in the middle, called the Move 
joystick,  moves the frame of the window 
you are viewing through to one of the four 
directions or diagonally.

The bottom slider zooms you in and 
out. As you move closer to the ground, 
Google Earth swoops (tilts) to change 

your viewing angle to be parallel to the 
Earth’s surface. 

If you see the little blue circle in the 
bottom right of the screen spinning, it’s 
calculating, give it a moment to catch up. 
When it’s solid blue, the image is as good 
as it’s going to get.

Looking Around versus Moving Around
 In Google Earth, you can look around 

and move around. These are different 
and it is useful to know the difference. 
Looking around involves gazing from a 
single vantage point, as if you were turn-
ing your head. Moving around involves 
shifting your location from one place to 
another. Both actions change your per-
spective. Play with it until you understand 
the difference.

You can also move using the arrows on 
your keyboard. And check the Help for 
useful information and video tutorials, 
it’s excellent!
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Beginner’s Circle is 
Working!

by Sue Beal

Thanks to Karen Strobel’s great sug-
gestion, we started the Beginners Circle 
a couple of months ago. I was hesitant 
to take on the responsibility because 
at 6:30 before our meetings, I am busy 
getting ready for the meeting... but I 
do have time to cruise by, listen to the 
problem and snag someone who might 
be able to help. (I don't know all the 
answers anyway — who does?!)

So MaryAnne Roper gets the “Oh, 
Duh!” award this month for fi gur-
ing out what was wrong with Joleen 
Barrett’s iPhoto.

We all looked at it... MaryAnne was 
the one who stuck to it until she solved 
it. And when she did, it was one of those, 
“Oh, Duh! I knew that” moments!!

Joleen’s iPhoto was “stuck” in the big 
picture view - where one photo takes up 

MU

the whole window area. She’d restarted, 
double-clicked, checked Help, done ev-
erything she could think of... but she 
could not get it to go back to the lightbox 
view (where all the pictures in a folder 
line up small and side by side).

The problem, simple, once MaryAnne 
pointed it out, was that the size slider 
bar had gotten pushed all the way over 
to the right - so the smallest view was 
taking up the whole screen!

There’s No Place Like Home
To get back to your favorite view, double 

click My Places in the middle part of the 
sidebar. To set your favorite view, navigate 
there and make sure it’s how you like it, 
then go to the View menu and select “Make 
this my start location.” Now you’ll see it 
listed under My Places in the sidebar.

Searching
When you type a location into the 

Search fi eld, Google “fl ies” you there, 
with breathtaking animation. This alone 
is worth the price of admission!

You can search for a country, a land-
mark, a specifi c city, latitude/longitude, or 
an address...  give it a try! You get Google's 
trademark locator matches in a list below 
the Search fi eld, when appropriate, to help 
you further refi ne your search.

If you search for a landmark, something 
well known (we did the Sphinx), you’ll 
see Google markers pop up. Click on the 
markers (if they are piled up - multiple 
points jammed together - they will split 
apart for easier viewing.) Click on any 
single marker and you may get Wikipedia 
information and pictures! (Because WIKI 
means people can contribute to content, 
you also might fi nd errors.)

Layers
There is a lot of content in Layers. 

Play around with the Layers and see 
what they do, and in which combina-
tions. One to defi nitely try, in an urban 
location, is 3D buildings!

Placemarkers
You can mark favorite locations. Look 

at the top of the Window, under the title 
bar. There are some little icons there. 
The fi rst (on the left) toggles to hide 
and show the sidebar. The second is 
the Placemark.

Navigate to the location you want 
to mark. Click the Placemark icon. 
A window will pop up, and pushpin 
will appear in the middle of the main 
window. Fill in the blanks and position 
the pin perfectly, the click OK. You’ll 
see the placemark appear under your 

Google Earth
continued from page two

My Places list.
You can get Google Earth to fl y you 

around the globe from location to loca-
tion to location. Set a series of Place-
markers as described above. Then go to 
the Add menu and select Add a Folder. 
Drag and drop the places you marked 
into it; drag them around in the folder 
until you like the order they’re in.

Now, select the folder and hit the play 
button (at the bottom of the Places sec-
tion of the sidebar, or choose Play Tour 
from the Tools menu). You’re fl ying!

You can also set up tours to give direc-
tions from one place to another. Once 
set up, tours can be exported and sent 
to others. The fi les are small and email 
easily. On our PBworks website is a tour 
you can download and play, one we made 

that evening. Also on the website is a 
download of the handout Kathy gave us 
on the history of Google Earth.

Google Heavens
As if all of the Earth wasn’t enough 

to explore from your desktop, Google 
Earth includes Google Heavens. Look 
at the icons at the top under the title 
bar, and you’ll see one that looks like 
Saturn. Click on this and you enter 
outer space with emphasis on the Moon 
and Mars. Check it out!

Special thanks to Kathy Miller for 
all her hard work preparing for this 
presentation. The evening was amaz-
ing, from the subject matter to the 
speaker’s wardrobe. She defi nitely 
gets the UKMUG “Easy on the Eyes” 
award!!

Remember, Kathy is an actress... 
catch her in the Key Players’ Septem-
ber production of Weekend Comedy. 
Go to www.thekeyplayers.org for 
more info!

Google Earth is a free download 
from http://earth.google.com/... there 
is a pro version available for $400 but 
if you’re interested in this intro-level 
article, that’s more than you need!

You need a G4 Mac or better, with OS 
10.4.11 or better, to use the 5.0 software.

Google Heavens!
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Digital Photography
& Photoshop CS4

Lessons Available 
Locally

One on One
$25 per hour.

Groups of 3 to 4
$25 pp per hr.

Field Trips Available
$50 pp for 4 hours,

for min. 4 to max. 8 people.

For more info:

Pete Bacheler
305.522.4863

flphoto@me.com
www.photone.net • pbacheler.smugmug.com

Snow Leopard: There 
is no free lunch!

From Ric Ford’s MacIntouch
Submitted by Tom Mulhall

Trend Micro warns of a nasty bit of 
Mac malware masquerading as a Snow 
Leopard download:

Bogus Snow Leopard Update Sites Lead 
to DNS Changers  

 Before the August 28 official re-
lease of Apple’s OS X Snow Leopard, 
cybercriminals are already hitchhiking 
on this to proliferate their malicious 
activities. Earlier today, Advanced 
Threat Researcher Feike Hacquebord 
discovered several fake sites that sup-
posedly give Mac users free copies of 
the newest version of the Mac OS, Snow 
Leopard. However, accessing these 
malicious sites land users to a DNS 
changer Trojan detected by Trend Micro 
as OSX_JAHLAV.K.   Once executed, 
OSX_JAHLAV.K decrypts codes, which 
include a script that downloads other 
malicious scripts. The said script then 
alters the DNS configuration and in-
cludes two additional IP addresses in 
its DNS server. Users are thus possibly 
redirected to phishing sites and other 
fraudulent sites.

TIPS FROM TOM

Save Your Laptop from a Liquid Spill
We have seen a rash of liquid spills recently on portable computers, with a 

variety of “fixes” attempted in many of the cases.  Considering that virtually 
none of those that we have witnessed over the last several months really work, 
I wanted to get some information out to let everyone know just what the proper 
procedure is if you happen to be unfortunate enough to suffer from “liquid 
incursion”.

First, as a general rule, the more complex and exotic the liquid is, the higher 
the chance that your precious portable will be ruined beyond repair (a unit 
inundated with a rum and coke, or a piná colada will certainly suffer far worse 
than one which has a simple tap water spill!).

If you should be unfortunate enough to have a spill, first and foremost shut off 
the computer immediately.  Then quickly remove ALL power-- both the charger 
must be disconnected and the battery must be removed.

Now turn the unit over, with the area into which the liquid entered facing 
down.  With a soft cloth or towel, carefully wipe down the unit to remove any 
standing (or by now, dripping, liquid).  Leave the unit upside down-- the premise 
here is that any liquid entering the computer will most easily exit by the same 
route-- you do not want it to go elsewhere!  Periodically wipe down the upside 
down surface to remove any liquid that has flowed back out form the delicate 
innards of your system.

Now is the time to contact your computer service provider and arrange to get 
the system to the professionals to have them attempt to save your computer.  
Time is of the essence here.

Now-- what NOT to do....
• Do not wash out your computer with fresh water (or soda water either!).
• Do not put your computer in a warm oven overnight.
• Do not turn the unit on to heat it up to dry out the liquid.
• Do NOT put the computer in the washing machine.
• Do not use a hair dryer on the computer-- for too many reasons to list!

The best fix for liquid incursion into any computer, or keyboard for that mat-
ter, is to follow my simple three foot rule-- all food and drink should be kept at 
least three feet from your computer!
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Make Your Own Comics!
by Karen Beal

Ok, I’m no competition to Charles Schultz, but this is a fun little site to get 
creative. Especially good one for kids to try - but they let adults use it too.

This is my first attempt, and here's the site:
 http://www.makebeliefscomix.com/Comix/

Skitch?
by Karen Strobel

Free fun with images
Skitch is a fun screen capture tool 

that lets you grab images of web sites, 
applications, chats or your photos, and 
then annotate them with circles, arrows 
or text (either typed or freehand). It’s 
quick and easy to use and lots of fun.

http://skitch.com/

MU

MU

More Earthy Delights: GeoCaching

Are you aware of the ‘Yellow Arrow’ ?
from Karen Beal and Judy Hull

Participants place uniquely-coded 
Yellow Arrow stickers to draw atten-
tion to different locations and objects 
- a favorite view of the city, an odd fire 
hydrant, the local bar. By sending an 
SMS from a mobile phone to the Yel-
low Arrow number beginning with the 
arrow’s unique code, Yellow Arrow 
authors connect a story to the loca-
tion where they place their sticker. 
Messages range from short poetic frag-
ments to personal stories to game-like 
prompts to action. 

When another person encounters 
the Yellow Arrow, he or she sends its 
code to the Yellow Arrow number and 
immediately receives the message 
on their mobile phone. The website 
yellowarrow.net extends this loca-
tion-based exchange, by allowing par-

ticipants to annotate their arrows with 
photos and maps in the online gallery 
of Yellow Arrows placed throughout 
the world.

Judy says she's seen some in the 
Keys! MU

Recovering a File you 
Clobbered

Steve Henning, LehighValley MUG

Here’s a hint for recovering from 
overwriting an existing file.  I some-
times create a new file by modifying 
an existing file and then I mess up and 
inadvertently save it under the original 
name rather than the new name. This 
destroys the original file, but is very 
easy to recover from IF YOU CATCH 
IT IN TIME. 

You just save the file again, under a 
new name. Then, hit “undo” until you 
get back to the original file and then 
save that under the old name. I have 
had to do this several times recently. 

[Note: this works in lots of programs! 
You just have to catch it before you 
close the document.—Sue]

Get That Family Organized!
submitted by Karen Beal

Wish you had some help organizing your family life? Cozi is a FREE web 
service that helps you manage your family calendar, track your shopping and to 
do lists, organize your chores, and share favorite memories with your friends 
and relatives. Access Cozi from anywhere—home, work, or on the go—with any 
computer or mobile phone. All you need to 
get started is a Cozi account—it’s quick and 
easy, with no downloads required!
• All your appointments in one place, 

color-coded by family member. 
• Cozi remembers your grocery list, 

shopping list, to do lists, chores, and 
more—so you don’t have to.

• Get appointment reminders by text and 
email. Or send a quick message right 
from your family home page.

www.cozi.com

Free Music!
by Karen Beal

Check out the free classical catalog 
at ClassicCat.net. Or go for the free 
downloads section at Rhapsody.com. 
Want country? At CountryWeekly.com, 
click on Free Music Downloads under 
Music. At Amazon.com, click on Digi-
tal Downloads from the lefthand menu, 
then MP3 Downloads. On the left under 
Browse MP3s, there’s a Most Popular 
category. There you’ll see an option for 
Free Songs & Special Deals.MU
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FREE OS X CLASSES
The Apple Store at the Falls

has free OS X classes every 

Saturday from 9-10 am! 

Call for more info:

Apple Store at The Falls
305-234-4565 
8888 SW 136th Street, 
Miami, FL 33176  

Mon-Sat:10am-9:30pm
Sun: noon-7pm
http://www.apple.com/retail/thefalls

MU Classifieds •  MU Classifieds

Call or email Sue if you have 
something to give away or sell! 

Classified ads are free.
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The Upper Keys Humane Society has an 
IMAC COMPUTER FOR SALE. It was 
purchased new last November but has 
never been used. It was purchased for 
bookkeeping and general office use but 
the bookkeeper did not like the payroll 
program (Aatrix) so they decided to go 
back to a PC. The specs are as follows:

OS 10.5.5, 2008, 17" display 

1.893 MHz core 2 duo processor

512 MB memory

149 GBHD

Model FA710LL/A

Applecare Protection Plan

Asking price is $850.00

Contact John Thomas at (305) 451-4516 
if interested

VISIT

http://ukmug.pbworks.com/

UKMUG’s Collaborative Website

Post questions 
and requests for help

Post tips and tricks

Post your favorite links

Comment on all things Mac 
and UKMUG

Check on upcoming meetings

MU

Upgrade, Update... What’s the Difference?
by Gary E. Kampel, Regional Liaison, SEMUG

Upgrade
An Apple “software upgrade” 

means a major, standalone version 
of a software product. Such products 
are usually something you purchase. 
They are shipped in a box or shrink-
wrapped package. Mac OS upgrades 
are sometimes also called “reference 
releases.”

For example, Mac OS X 10.5 (Leop-
ard) and Mac OS X 10.4 (Tiger) were up-
grade products. Are or were available 
from an Apple reseller, Apple Retail 
store, or the Apple Store Online.

Update 
A “software update” updates a major 

(reference release) version of software, 
but does not upgrade it to the next 
major version (if one exists). For ex-
ample, you can download a web update 
to update Mac OS X 10.5 to Mac OS 
X 10.5.5, but you can’t download an 
“update” to upgrade from Mac OS X 
10.4 to 10.5 (because 10.5 is an major 
upgrade).

An update is generally smaller in 
size than an upgrade. An update is 

something you can download, unlike 
a software upgrade. It’s wise to install 
the latest updates available for a soft-
wareproduct. You can use an update 
only if there is a prior version of the 
software installed on your computer. 
Mac OS upgrades are sometimes also 
called “maintenance releases” or “dot 
releases”.

For example, the Mac OS X 10.4.11 
Update is a downloadable update for 
Mac OS X 10.4. Mac OS X 10.3.9 Update 
is a downloadableupdate for Mac OS 
X 10.3. You can’t install the 10.4.11 
update on top of Mac OS X 10.3, nor 
can you install the 10.3.9 update on an 
existing Mac OS X 10.4 installation. |

Key differences
• A software update is usually down-

loadable; a software upgrade usually 
is not.

• A software upgrade usually incre-
ments the first “dot” number of a prod-
uct (for example Mac OS X 10.5, Mac 
OS X 10.2, Mac OS 9); a downloadable 
software update usually increments 
second “dot” number (for example, 
Mac OS X 10.3.9, Mac OS X 10.5.5).

Read About Apple in 
the Marketplace

“... Apple has gone from 60% of the 
over $1,000 market at the start of last 
year to that 91% number now. Last 
week Apple beat analysts estimates 
and shipped 2.7M Macs in 2nd quarter 
...” Read the entire article.

http:/ /www.edn.com/blog/
920000692/post/920047292.ht
ml?nid=3351&r\id=4319974 MU


